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УДК 378.147 
Юлія Кулінка 

 
ФОРМУВАННЯ ДИЗАЙНЕРСЬКОЇ КУЛЬТУРИ  

МАЙБУТНІХ УЧИТЕЛІВ ТРУДОВОГО НАВЧАННЯ  
ЗАСОБАМИ ПРОЕКТНИХ ТЕХНОЛОГІЙ 

 
Одним із необхідних елементів культури сучасної людини є 

освіченість в галузі дизайну, отримання якої повинно розпочинатись на 
стадії формування естетичних потреб та смаків, тобто з самого 
дитинства. У статті проаналізовано підходи до визначення дизайнерської 
культури як важливої складової фахової підготовки майбутнього вчителя 
трудового навчання; розкрито особливості формування дизайнерської 
культури у студентів у процесі роботи над дизайнерськими проектами. 
Подано приклад розробки міждисциплінарного проекту, робота над яким 
сприяла дизайн-діяльності студентів. 

Ключові слова: культура, дизайн, дизайнерська культура, проект, 
проектування, дизайн-проектування, проектна культура, рекламний 
дизайн-проект, тюнінг сучасного автомобіля. 

 
Одним из необходимых элементов культуры современного человека 

является образованность в области дизайна, получение которой должно 
начинаться на стадии формирования эстетических потребностей и 
вкусов, то есть с самого детства. В статье проанализированы подходы к 
определению дизайнерской культуры как важной составляющей 
профессиональной подготовки будущего учителя трудового обучения; 
раскрыты особенности формирования дизайнерской культуры у 
студентов в процессе работы над дизайнерскими проектами. Приведен 
пример разработки междисциплинарного проекта, работа над которым 
способствовала дизайн-деятельности студентов. 

Ключевые слова: культура, дизайн, дизайнерская культура, проект, 
проектирование, дизайн-проектирование, проектная культура, рекламный 
дизайн-проект, тюнинг современного автомобиля. 

 
One of the essential elements of the culture of modern man is educated in 

design, receipt of which must start at the stage of aesthetic needs and tastes, if 
since childhood. Design education involves introducing the basics of design as a 
discipline has great educative potential of the entire education system, not only 
in professional designer. In the process of design education is education, 
education, human development and formation of thinking project. The article 
analyzes the approaches to the definition of design culture as an important part 
of professional preparation of future teachers of labor studies; The features of 
the formation of the design culture of students in the process of design projects. 
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Examples of interdisciplinary development project, on which work contributed 
to the design of students. To determine the nature of the design culture of the 
future teachers of labor studies, the article describes such important categories 
as culture, design, project culture and design. 

Key words: culture, design, design culture, design, design, design, design 
culture, advertising design project parts of the modern car. 

 
На сьогоднішній час суспільство потребує висококваліфікованих, 

естетично грамотних кадрів, здатних до самостійного трудового життя в 
умовах ринкової економіки, тому, доцільним є розгляд формування 
дизайнерської культури майбутніх фахівців та розвиток дизайн-освіти. 
Дизайн-освіта – це навчально-ігрова проектувальна діяльність тих, хто 
навчається, що забезпечує синтез сенсорного (чуттєвого, візуального), 
вербального (словесного), структурного (речовинного, запахо-смаково-
дотикового), інформаційних аналогів (елементів дизайну, інформатики, 
технології) з метою формування пропедевтичної інформаційної культури 
особистості. 

Дизайн-освіта припускає впровадження основ дизайну як 
дисципліни, що має великий освітньо-виховний потенціал, у всю систему 
освіти, а не лише у професійно-дизайнерську. У процесі дизайн-освіти 
відбувається навчання, виховання, розвиток і формування людини з 
проектним мисленням. 

Досліджували основи дизайн-освіти такі науковці як С. Кожуховська, 
Є. Клімов, О. Куліков, Н. Конишева, Л. Малиновська, В. Наумов, 
В. Пузанов, В. Розін, В. Сидоренко, Є. Ткаченко та ін. У формування 
сучасної української дизайн-освіти свій внесок вніс В. Тименко. Так, у 
своїх роботах він визначає дизайн-освіту, як проектування навчально-
виховного процесу на основі взаємодоповнюваності наукового й 
художнього пізнання способом моделювання вербальної та сенсорної 
інформації у вигляді образів-понять. Зазначене формулювання відображає 
специфіку початкової дизайн освіти. Дизайн має змогу повністю розкрити 
складну взаємодію мистецтва і техніки, формувати естетичне ставлення до 
дійсності. Завданням дизайн-освіти є впровадження в розвиток 
дизайнерського мислення майбутніх фахівців, що сприяє розумінню 
сучасних мистецьких проблем, естетичному вихованню.  

Учені-педагоги О. Коберник, В. Тименко, Т. Шевчук, вказують, що 
дизайн-діяльність у даній освіті є основним способом художнього 
розвитку особистості, провідним засобом її художнього розвитку. 

Мета статті – обґрунтувати особливості формування дизайнерської 
культури у майбутніх учителів трудового навчання засобами проектних 
технологій, розкрити можливості сучасної дизайн-освіти у фаховій 
підготовці майбутніх педагогів. 

Щоб визначити сутність дизайнерської культури майбутнього 
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вчителя трудового навчання, потрібно охарактеризувати наступні важливі 
категорії: культура, дизайн, проектна культура, проектування. У 
загальному трактуванні «культура» (від лат. colere, cultura) в час його 
функціонування в античному світі мало багато значень: «вирощування», 
«зрощення», «догляд», «обробіток», «поліпшення», «створення», 
«формування» та ін. Нині тотожне використання його в науковій практиці 
неможливо, хіба що стосовно людини його можна трактувати яку 
вирощення, формування, вдосконалення її образу. 

Культура в різних її проявах є об’єктом і предметом дослідження 
багатьох наук, тому зараз налічується майже 300 її визначень. У статті ми 
використовуємо два основні напрями трактування культури, що 
найчастіше використовуються у науковій літературі: 1) сукупність 
матеріальних і духовних цінностей, які створюються людиною в процесі її 
життєдіяльності; 2) форма самореалізації людини в усьому її різноманітті, 
спосіб буття людини [1]. Ці визначення ми вважаємо оптимальними, 
оскільки проектний вид культури тісно пов’язаний із створенням 
матеріальних і духовних цінностей та можливостями самореалізації 
педагогів у процесі їх продуктивної діяльності. 

Ємність й універсальність поняття «культура» дозволяють 
розглядати її поліваріантно, багатоаспектно: як зріз суспільного життя, 
характеристику рівня розвитку особистості, систему суспільно 
регулятивних норм, механізм трансляції досвіду, феномен само 
детермінації тощо.  

Існують різні підходи до визначення суті культури. Так, діяльнісний 
підхід в філософії, психології і педагогіці розробив видатний вітчизняний 
психолог і філософ С. Рубінштейн [5]. На його думку, людина та її психіка 
формуються і виявляються первісно в практичній діяльності й тому мають 
вивчатися через їх виявлення в основних видах діяльності (праці, пізнанні, 
учінні, грі тощо). Основними особливостями діяльності С. Рубінштейн [5] 
уважав: соціальність – діяльність здійснюється лише суб’єктом (людством, 
групою людей, особистістю); діяльність як взаємодія суб’єкта з об’єктом є 
змістовою, предметною, а не суто символічною і фіктивною; діяльність 
завжди творча й самостійна. 

Одним із необхідних елементів культури сучасної людини є 
освіченість в галузі дизайну, отримання якої повинно розпочинатись на 
стадії формування естетичних потреб та смаків, тобто з самого дитинства. 
Дизайн – це якісно новий тип діяльності, який інтегрує технічну та 
гуманітарну культуру на проектній основі та направлений на організацію 
гармонійного предметного середовища. Дизайн сьогодні пронизує 
фактично всі сфери життя розвинутих країн.  

Термін дизайн на сьогодні, певне, один з найуживаніших термінів. 
Його застосовують у мовленні у різних контекстах, проте кожен 
намагається подати власне значення та трактування. Так, на думку 
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С. Шумеги, «сьогодні вже немає сенсу сперечатися щодо того, куди 
віднести дизайн: до мистецтва чи до техніки. Усі нарешті дійшли 
висновку, що дизайн – це самостійний напрям проектної діяльності 
промислових виробів з усіма притаманними йому атрибутами: історією, 
теорією, практикою, які пов’язані з мистецтвом і технікою, проте питання, 
як і чого навчати майбутнього фахівця – дизайнера, своєї актуальності ще 
не втратило» [3]. 

Дизайн (від латинського слова design – проектувати, креслити, 
задумати а також проект, план, рисунок) – вид діяльності, пов’язаний з 
проектуванням предметного світу. Майбутні вчителі трудового навчання 
(дизайнери) розробляють зразки раціональної побудови предметного 
середовища, вивчають естетичні властивості промислових виробів тощо.  

Погляди науковців на дизайн як вид художньої діяльності 
(Е. Давидова, В. Ванслов), як вид техніко-естетичної творчості 
(Ле. Корбюз’є), як вид проектування (Л. Безмоздін, В. Плишевський, 
Ю. Соловйов, М. Федоров), як невід’ємну складову частину проектування 
(Б. Арчер, Дж. Джонс), як складову проектно-технологічної діяльності 
(В. Харитонова) відображають його суттєві риси як категорії естетичної 
діяльності.  

Подальший розвиток цього поняття привів до нової концепції 
дизайну, згідно якої він є особливим якісним етапом розвитку проектного 
мислення і діяльності (проектна культура), на якій ґрунтується проектна 
система, що включає різні інженерно-технічні та гуманітарні дисципліни, 
де першорядну позицію займає проблемно орієнтоване художньо-проектне 
мислення [6, с. 14]. 

Як один із видів професійної діяльності дизайн впливає на 
особистість. Проектна уява і культура – це базові поняття в професійній 
діяльності дизайнера (С. Хан-Магомедов, В. Шимко). Проектуючи предмети 
і створюючи предметне середовище, дизайнер «проектує» і людину. 
Формування якісно нового мислення в процесі створення середовища, що 
забезпечує максимально сприятливі умови життєдіяльності людини, є 
головним завданням вищого навчального закладу. 

Значно конкретнішим є визначення проектування як процесу 
створення прототипу, прообразу передбачуваного або можливого об’єкта, 
стану [7]. Слово «проект» – латинського походження буквально означає 
«кинутий вперед», «виступаючий» тощо. У Великобританії є такі 
інтерпретації цього поняття: 1) дизайн – документально оформлений план 
споруди або конструкції; 2) проект – система сформульованих у його 
рамках цілей (новостворених або таких, що підлягають модернізації) з 
метою реалізації фізичних об’єктів, технологічних проектів, процесів тощо 
[4]. В українській мові проект має такі значення: 1) технічні документи – 
креслення, розрахунки, макети новостворюваних будівельних споруд, 
машин, приладів тощо; 2) попередній текст якого-небудь документу та ін.; 
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3) план, задум [2, с. 175−176]. 
Базуючись на таких визначеннях проекту, О. Марущак стверджує, 

що проектування – це розумова діяльність, яка визначає майбутній процес 
і результат перетворення дійсності з урахуванням природних і соціальних 
законів, на основі вибору й ухвалення рішень. У проектуванні важливо 
підкреслити його ідеальний характер; дії виконуються не з реальними 
явищами чи процесами, а з їх уявними моделями [2].  

У контексті розвитку проектної культури вчителя технологій 
О. Марущак та Д. Луп’як виокремлюють інженерне, педагогічне та дизайн-
проектування [2, с. 176]. Дизайн-проектування – це особливий вид творчої 
діяльності, пов’язаний з розробкою дизайн-об’єкта за принципом: 
функціональність + конструктивність + краса, що поєднує в собі наукове 
та інтуїтивне передбачення і потребує постійного розвитку проектних 
здібностей. В основі дизайн-проектування є художнє конструювання, що 
передбачає висунення нової художньо-проектної ідеї та умови її 
раціонального втілення. 

З метою формування дизайнерської культури майбутніх учителів 
трудового навчання є практична розробка дизайн-проектів різної тематики. 
Особливого значення набуває міждисциплінарне проектування. Так, 
студентами спеціальності «Технологічна освіта (технічна та комп’ютерна 
графіка)» розроблено рекламний дизайн-проект на тему «Дизайн сучасного 
автомобіля (тюнінг)», що спрямований на формування графічних, 
конструкторських та дизайнерських умінь і навичок, а також закріплення 
знань з автосправи. 

У Вступі обґрунтовано, що основними напрямами у вирішенні 
дизайну автомобіля є не тільки і не стільки удосконалення самого об’єкта 
розробки, а планування і організація універсальної системи його 
«життєдіяльності», середовища існування із урахуванням взаємодії з 
іншими учасниками цієї системи на всіх етапах створення об’єкта.  

Дизайн автомобіля, як і будь-якого промислового виробу – це не 
ескіз корпусу, це повний цикл виведення виробу на ринок, в якому 
аналітична робота є ключовою. Гармонійний компроміс між зручністю 
експлуатації і зовнішнім виглядом є завданням дизайнера. Під зручністю 
тут розуміють комфорт, як у процесі безпосередньої експлуатації, так і під 
час будь-яких сервісних робіт. 

Об’єктом проектування визначено рекламна дизайн-розробка 
сучасного автомобіля, що базується на такій формі як автотюнінг. 

На організаційно-підготовчому етапі розкрито актуальність 
дослідницької роботи. Автомобільний дизайн, що базується на технології, 
яка вимагає від проектувальників знань процесу моделювання й 
виробництва нового виробу. Кузов автомобіля і внутрішній інтер’єр є 
взірцем того, наскільки важливий дизайн, тому виробники використовують 
рішення з максимально можливим ступенем концептуальності і зберігають 
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високий рівень геометричної точності. Конкуренція, сучасні технології і 
підвищені вимоги щодо безпеки вимагають від дизайнерів бути 
далекобачними і підготовленими. Їм потрібні інструменти, що прискорюють 
креативність автодизайну і гарантують подальше удосконалення 
конструкції. 

Проблема, що піднімається у роботі, стосується удосконалення 
дизайну сучасного автомобіля та автотюнінгу, так як застосування 
низькоякісних матеріалів та недостатньої комплектації масових 
бюджетних автомобілів, їх посередньої керованості та динаміки вливають 
на зовнішній вигляд та зносостійкість автомобіля. Причини полягають у 
розгляді можливості поліпшення комфорту, крім цього в бажанні 
виділитися або ж просто перетворити зовнішній вигляд авто у 
відповідності до смаку власника. 

При описі інноваційного дизайну сучасного автомобіля обґрунтовано 
об’єктивні критерії, що формують вигляд сучасного легкового автомобіля. 
Найбільший вплив на його формування має призначення, компонування, 
вимоги безпеки, аеродинамічні вимоги, застосовувані матеріали і 
технологічні процеси, умови експлуатації, естетичні вимоги тощо. 

У параграфі «Історія виникнення автомобільного тюнінгу» описано 
особливості появи та історію розвитку тюнінгу. У сучасному розумінні 
тюнінг зародився наприкінці п’ятдесятих років у США. Серед забезпеченої 
молоді були дуже популярні гонки на чверть милі (402 метри) – драй 
ресінг. Суть їх така: за сигналом два автомобіля зриваються з місця на 
прямій ділянці дороги довжиною 402 метри, хто перший перетне фінішну 
риску, той і переможець. Усе гранично просто – немає складних поворотів, 
необхідність віртуозного водіння автомобілем незначна, єдине, що 
потрібно від гонщика – це своєчасне переключення передач. У кінцевому 
підсумку, перемога залежить не від умінь водія, а від грошей, вкладених у 
автомобіль, щоб зробити його потужним та легким, відповідно і більш 
швидким, ніж у суперників. Проте саме ці гонки частково стали початком 
тюнінгу в його сучасному розумінні. Якби всі так виступали на серійних 
машинах, гонка могла втратити зміст, оскільки шанси в усіх було б рівні. 
Тож у роботу включилася інженерна думку умільців. 

Слід зазначити, що перегони драгстерів породили одне з 
радикальних напрямів тюнінгу – хот-родинг. Сам термін – американське 
слово англійського походження хот-род (hotrod) – це сленгове скорочення 
від hotroadster (гарячий родстер), а aroadster, у свою чергу, – скорочення 
від roadmaster, що є інверсією від master ofroad (господар дороги). 

Ход-родинг полягає у серйозній переробці старих автомобілів 
(переважно 30–50-х років), мета якої – з безневинного раритету створити 
чудовисько з двигуном потужністю до 1000 л/сек і більш, що має значну 
розгінну динаміку. Зовнішній вид початкової машини може з великими 
труднощами вгадуватися у хот-роді, хіба що знавцями автостаровини. 

Подано класифікацію тюнінгу за різними видами і формами (мал. 1). 
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Мал. 1. Класифікація тюнінгу автомобіля 

 

У другому конструкторському етапі з метою генерування початкових 
ідей та вибору найдосконалішої, розглянуто найпопулярніші напрями 
американської школи тюнінгу, як самої досвідченої, а саме: 1) стрит-
родинг (streetrod) – зовнішні переробки автомобіля не культивуються, зате 
повністю змінюється «начинка»; 2) кастом (kustom) – зовнішні переробки 
дуже схожі на за своєю сутністю на класичний хот-род, автомобіль 
повинен викликати захоплення; 3) чоп топ (choptop) – зменшення висоти 
даху шляхом укорочування довжини стійки (на 10–20 см), що дає машині 
більш грізний вигляд і покращує аеродинаміку; 4) лоурайдер (lowrider) – 
зміна підвіски на пнематичну; 5) ледслед (leadsled) – зменшення кліренсу 
на кілька сантиметрів і відсутність в підвісці пневмо-елементів;6) кіткар 
(kitcar) – перекладається «автомобіль із комплекту»; 7) реплікар (replicar) – 
перекладається «автомобіль-копія». 

Далі здійснюється аналіз моделей аналогів (табл. 1). 
Таблиця 1 

Аналіз моделей аналогів з вибором елементів для автотюнінгу 
 

Модель Зразок моделі Опис та характеристика 
Аналіз 
вибору 
елементів 
для тюнінгу  

1 2 3 4 
Модель №1 
Авто-
мобіль 
марки 
Lexus 
LF-SA 

 

Решітку радіатора, яка 
виглядає сучасно та 
креативно. Дивовижний 
дизайн, який, незважаючи на 
рвані лінії кузова, виглядає 
цілком гармонійно і на диво 
не викликає відрази. Дизайн 

Тюнінг 
коліс, 
решітки 
радіатора та 
передньої 
частини 
авто. 

ТЮНІНГ АВТОМОБІЛЯ 

Рінгтул – тюнінг автомобіля, 
який готується прийняти участь 
в якій-небудь гоночній серії 

Стайлінг – зміна зовнішнього вигляду або 
салону автомобіля, для створення 
індивідуального стилю, що виділяє автомобіль 
в потоці та привертає увагу оточуючих 
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сучасної передньої частини 
автомобіля, дизайн-руху 

Вид хот-
роду-каст 

Модель №2 
Авто-
мобіль 
марки  

Opel Astra 

 

Нове покоління Opel Astra 
має оригінальний дах, що не 
тільки створює літаючий 
ефект, але і робить 
автомобіль витонченішим і 
візуально довшим. 
Атодизайнери створила 
оригінальні задні стійки 
кузова, які затемнили, що 
створює ефект, ширяючого 
даху.  

Ефект 
літаючої 
криші, 
кольорова 
гама 
Вид хот-
роду-
лоурайдер 

Модель №3 
Авто-
мобіль 
марки  
BMW 

  

Підвищення аеродинамічних 
функцій авто за рахунок 
тюнінгу переднього бамперу 
та спойлеру, який 
встановлений під бампером 
регулює потік повітря і 
спрямовує його вверх. 

Тюнінг 
переднього 
бамперу зі 
спойлером, 
фар. Вид 
хот-роду-
кіткар 

Модель №4 
Авто-
мобіль 
марки  
Niva 

 

 

Своєрідні тематичні 
малюнки нанесені на авто – 
це цікавий і оригінальний 
спосіб звернути увагу водіїв 
до деталей автомобіля, які 
можливо виглядають в 
сучасних машинах марно. 

Аерографія 
авто. 
Вид хот-
роду –
стайлінг та 
вініл 

 
Для розробки та дизайну автомобілю було обрано автоматизовані 

засоби та програми комп’ютерної графіки (CorelDRAW, Adobe Photoshop). 
На технологічному етапі було розроблено тюнінг модифікованого 

автомобіля у програмі Adobe Photoshop (табл. 2).  
Таблиця 2. 

Приклад технологічної карти автотюнінгу сучасного автомобіля 
у Adobe Photoshop 

 

№ Послідовність виконання дій Малюнок 
1 За допомогою Pen tool створіть контур 

навколо кузова автомобіля. 
У палітрі контури (Window> Paths), 
клацніть правою кнопкою миші по 
створеному контуру і виберіть Make 
Selection. Далі Select> Modify> Feather, 
радіус розтушовування 0.3 пікселя.  
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2 Виберіть Edit> Copy, щоб скопіювати 
виділену область в буфер обміну. 
Відкрийте іншу фотографію з 
автомобілем, яка знаходиться під 
схожим кутом. Ця фотографія буде 
служити для створення фону і коліс для 
нашого автомобіля. Вставте зображення 
в наш документ (Ctrl + V or Edit> Paste). 
Використовуйте інструменти 
трансформації (Edit> Transform> *), для 
того, щоб повернути корпус так, щоб 
він покрив наш автомобіль. 

3 За допомогою Lasso tool, створіть 
виділення нижньої частини автомобіля 
на фоновому шарі. 
Створіть новий шар між двома 
створеними шарами і заповніть 
виділену область чорним кольором. 

 
На технологічному етапі проведено маркетингові дослідження та 

розрахунок собівартості рекламного банеру із зображенням тюнінгу 
сучасного автомобіля (мал. 2). 

 
Мал. 2. Рекламний банер «Тюнінг сучасного автомобіля» 

 

Висновки. Реалізація проектної технології з метою формування у 
майбутніх учителів трудового навчання дизайнерської культури, дозволяє 
виконати ряд графічних, практичних, пошукових та дизайнерських робіт, 
дозволяє сформувати і закріпити знання з комп’ютерної графіки, 
автосправи та методики трудового навчання, сприяє розвитку проектного 
та технічного мислення. Робота над таким міждисциплінарним проектом 
відкриває перед студентами можливості оволодівати узагальненими, 
сукупними знаннями, спроможними звільнити їх від однобічного розвитку 
і прискорити розширення їхнього світогляду. Перспектива подальших 
розвідок полягає в обґрунтуванні розвитку дизайнерської компетентності 
студентів при розробці міждисциплінарних проектів різної спрямованості. 
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